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Minimum System Requirements 
The following requirements are for Perspective™ operating in a traditional LAN/WAN environment with the web 
server component running on a separate Microsoft® IIS box. These configurations are for planning purposes only—
please work with your PPM 2000 Account Manager for a specific assessment of your needs. These requirements 
apply to Perspective v.3.3, Perspective Integration Services™ v.3.3, Perspective DispatchLog™ v.4.0, Perspective 
e-Reporting™ v.2.0, Perspective Focal Point™ v.1.2, Perspective Mobile™, Perspective Visual Analysis™ v.3.3 and 
Perspective Workflow™ v.1.0. 

Minimum Recommended 

Client Machine 

Processor Speed 1.5 GHz 3 GHz+ 

Memory  1 GB 2 GB+ 

Operating System  Windows® Vista SP 2 Windows® 7 SP 1 

.NET Framework  Version 4.0 Version 4.0 

Web Browser  Internet Explorer® 7.0 Internet Explorer® 9.0 

Third Party Application 

Adobe® Reader® 7.0.5+ 

Microsoft Office® 20071 
Sun Java™ Runtime Environment 6.0 U72  

QlikView™ Analyzer Plug-in for Internet Explorer®3 

Adobe® Reader® 9.4.0+ 

Microsoft Office® 20101 
Sun Java™ Runtime Environment 7+2 
QlikView™ Analyzer Plug-in for Internet Explorer®3 

Mobile Device
4
  See Perspective Mobile™ Supported Device List See Perspective Mobile™ Supported Device List 

Web Services Server
5, 6

 

Available Disk Space
7
  1 GB 1 GB 

Processor Speed  2 GHz 2 GHz multicore or better 

Memory  2 GB 4 GB+ 

Operating System  Windows Server® 2008 SP 2 64 bit Windows Server® 2008 R2 SP 1 64 bit 

.NET Framework  Version 4.0 Version 4.0 

IIS—Internet 

Information Services
8
 

IIS 7.0 IIS 7.5 

C++ Runtime Libraries C++ 2010 SP1 Runtime Libraries (x64) 10.40219 C++ 2010 SP1 Runtime Libraries (x64) 10.40219 

QlikView
™

 Server
9
 64 bit Version 9 SR 2 64 bit Version 9 SR 2 

SQL Server
®
 Machine

6
 

Available Disk Space  2 GB 20 GB+, SCSI Hard Drive 

Processor Speed  3 GHz 64 bit Server Dual Core or Multiple Processors 

Memory  2 GB 4 GB+ 

Database Server
10

 SQL Server® 2008 Standard SP 1 or R2 SQL Server® 2012 Standard or Enterprise 

Reporting Services  SQL Server® 2008 Reporting Services SQL Server® 2012 Reporting Services 

 

Deployment Note: Perspective client is deployed as a ClickOnce application, launched from Internet Explorer
®
; it has a 

zero client footprint and does not require administrative rights to launch. 

Network Note: If single sign-on authentication or add from Active Directory
®
 is used, the Active Directory

®
 Services must 

be enabled on the Perspective Services’ web server. 

DTC Note: Perspective Integration Services requires the Microsoft
®
 Distributed Transaction Coordinator (DTC) service to 

be installed and enabled on the Internet Information Services (IIS) for Windows
®
 Web Server and the Microsoft

®
 SQL 

Server
®
 for Perspective. 

1. This requirement only applies if using Outlook
®
 email integration. 

2. This requirement only applies to Perspective Visual Analysis. 
3. This requirement only applies to Perspective Focal Point. 
4. This requirement only applies to Perspective Mobile. 
5. These requirements apply to Perspective, Perspective e-Reporting, Perspective Focal Point and Perspective Workflow. 
6. These requirements are for systems with 5 to 25 concurrent users. For Perspective systems with less than 5 or more than 25 

concurrent users, please contact your PPM 2000 Account Manager for a specific assessment of your needs. 
7. Depending on the size of your Perspective database, more disk space may be required for Perspective Focal Point and Perspective 

Workflow. 
8. Requires IIS 6 Management Tools installed. 
9. This requirement only applies to Perspective Focal Point. A limited QlikView

™
 Server license is included with Focal Point. 

10. SQL Server
®
 2008 Express is only supported for the Standard Edition of Perspective. 
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Standard Install 

SQL Database Server 

1. Ensure Microsoft SQL Server 2008 Standard SP 1 or better has been installed. 

Note: If installing on Windows Server 2008, the database package must be run as an 

administrator. 

2. Install the Perspective database:  

a. Launch Microsoft SQL Server Management Studio. 

b. Right click DBS and select Restore Database.  

c. Under From Device, click the Browse (...) button and browse to the appropriate 

database: default, sample or system. 

Note: Standard backups can usually be found in Perspective Install > Database Setup 

> New. If you're unsure which database to use, contact your Perspective administrator. 

d. Click OK. 

e. Check the Restore option. 

f. Enter a database name in To Database, then click OK. The database should now 

appear in the database list. 

3. Create a new SQL user that will be used by Perspective to connect to the SQL Server: 

a. Launch Microsoft SQL Server Management Studio. In the menu on your left, expand the 

Security node, right-click Logins and select New Login. 
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b. In the Login – New form, under the General page, type in the Login Name and modify 

the rest of the options according to your preference. 

c. Open the User Mapping page. Check the appropriate boxes to grant the new account 

access to the Perspective database with the db_owner role membership rights, then 

click OK. 
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SQL Reporting Services 

1. Ensure that SQL Server Reporting Services is installed. 

2. From the Perspective install directory, copy the Reports Setup folder and all subfolders to a 

temporary directory on the Reporting Services computer. 

3. Edit the PublishServerReports.bat file in the temporary directory. Before making any 

changes, save a backup copy of the original PublishServerReports.bat file. 

 Edit databaseServerName to <Name_of_Database_Server>. 

 Edit databaseName to <Name_of_Database>. 

 Edit databaseUserId to <sql_User_Account>. 

 Edit databasePassword to <sqlUser_Password>. 

4. Save changes and run the PublishServerReports.bat file to publish reports to the Report 

Manager. If the file fails to run, see the “Troubleshooting Tips” section.  

  Windows Server 2008 Warning 

If installing on Windows Server 2008, the command contained in the batch file must be 

run from the Administrator’s Command Prompt window as this will require elevated 

permissions. The command must be launched from the directory in which the batch 

file is contained. 

5. Browse to your Reporting Services Web site (e.g., http://localhost/Reports/). 

a. On the Contents tab, click the Perspective folder. 

b. Click Properties, Security and New Role Assignment, then Edit Item Security. 

 

c. Enter a Service Account for the Perspective application to use when connecting to 

Reporting Services. Create a new local user, if you do not have one already. Ensure 

that the password is not set to expire. 
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d. Select the Browser role and click OK. 

 

Perspective Services (Application Web Server) 

1. Ensure Internet Information Services (IIS) is installed.  

  Application Pool 

As of Perspective Version 3.3, the appropriate application pool is set up as part of 

database setup and doesn't have to be done manually. 

2. From the Perspective Install > Web Service Setup > Perspective Services directory, run (as 

an administrator) Perspective.Services.exe. To complete the setup, follow the wizard's 

guidelines. 

a. If you already have Visual C++ 2010 SP1 Runtime Libraries (x64) and .NET 

Framework 4.0 installed, skip to step 2c. Otherwise, you will be prompted to install the 

Runtime Libraries and/or .NET Framework. 

Note: As of Perspective Version 3.3, the full Microsoft .NET Framework 4.0 pre-requisite 

installer is bundled into the Perspective installer. .NET Framework 4.0 is required; if it is 

not yet installed, it can be done so as part of this installation process. 

b. Click Install and wait for the process to complete. 
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Note: This process may trigger Windows' UAC (User Access Control) security feature. If 

prompted, click Yes to allow Perspective Services to install. 

c. Wait for the Perspective Service Setup Wizard to start.  

 

d. Read the License Agreement. If you accept the terms and conditions, select the 

appropriate radio button and click Next. 
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e. Select the appropriate installation directory. Click Next. 

 

f. In the following screen, click Next to confirm the installation. Wait while Perspective 

Services is being installed. 
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g. Click Finish once the installation is complete. 

Configure Connections Using Service Manager 

1. Install Perspective Service Manager: 

a. From your Perspective installation folder, run Service Manager Setup. The installation 

wizard appears; click Next to continue. 
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b. Read the License Agreement. If you accept the terms and conditions, select the 

appropriate radio button and click Next. 

 

c. Select the appropriate installation directory. Click Next. 

 

d. In the following screen, click Next to confirm the installation. Wait while Perspective 

Service Manager is being installed. 
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e. Click Finish once the installation is complete. 

2. From the Start menu, launch (as an administrator) Perspective Service Manager. You'll be 

prompted  to select  a Perspective configuration file. Navigate to the installed location of 

Perspective Services, select the Perspective_Default.config (default location: 

C:\inetpub\wwwroot\PerspectiveServices) and open the configuration file. 

You’ll be prompted for database information. 
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3. Enter a new name for Connection ID.  

Note: The Connection ID cannot contain the word “Default”. 

4. In the SQL Server lookup list, select your SQL Server or type the name of your server in the 

text box. 

5. Leave Default Language ID set to 0, unless instructed otherwise by PPM 2000. 

6. Ensure SQL Authentication is selected, and enter the SQL Username and Password 

created when installing the database. 

7. Select your Perspective database from the Databases lookup list. 

Note: If you receive an “Unable to connect to the named server” message, you have entered 

either the wrong SQL server name or credentials. 

8. Open the Product Validation component from the menu on the left, then click OK to save 

and add the primary connection. 

9. In the top field, enter your Company Name, as listed on the email provided to you with your 

license keys. 

10. Enter the Master Key that applies to the Company Name entered. Note it is case-sensitive. 

11. Click the Validate button. The fields below will indicate the number of active licenses, 

License Expiry Date, Product Level and specifications of individual Licensed Modules 

(i.e., Product, Number of Users and Expiry Date). 

Note: The Validate function will access a central licensing service hosted by PPM 2000 Inc. 

Internet connection is required to download your license file. 

Optional: If you do not have Internet connection available, you may contact Technical 

Support for your license file and manually update it in the License Location field. 
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12. Open the Database component from the menu on the left, double-click your database, open 

the Report Service tab and type the report server URL in the Report Server URL box. 

13. Click the Test button. You should receive a prompt telling you the URL is valid. If not, then 

double-check that your configuration is correct and try again. If you keep receiving an error 

message, please call the Technical Support team at 1-877-776-2995 for assistance. 

14. Enter the name of your Reports Folder. 

15. Proceed to the Report Service User section below. Enter the Domain, Username and 

Password that were granted browser rights when setting up the server-side reports. 

16. Click OK. 
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17. Select the Configuration component from the Perspective Service Manager menu. 

18. To encrypt the Perspective_Default.config file, select the Encrypt Configuration? 

checkbox. 

19. Open the Client-Side Configuration tab. 

20. Enter the Download URL for Client-Side Reports for the client reports configuration files 

to update automatically (i.e., http://<server name>/perspectiveservices/client). 
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Note: 'xxxx' in the above screenshot denotes the latest Perspective build number. 

21. Click Save Changes and click Yes on the save changes prompt. Then, close the Service 

Manager. 

22. Double check your IIS settings: 

a. View settings of the Perspective Services 3.3 Application Pool. 

b. Ensure Enable 32 Bit Applications is set to FALSE. If it is not, change accordingly. 

23. Restart IIS. 

  Advanced Configurations Warning 

Many options in the Service Manager are not covered in this step-by-step Standard Install 

walkthrough. For the list of supported advanced setup configuration options, please, refer 

to the “Advanced Configurations” section that appears later in this guide. It is 

recommended that all setups follow the standard setup procedures outlined in this section 

as an initial starting point. Advanced features can then be configured as needed, after the 

standard setup is running and connections have been verified. 

Client Machines 

1. Ensure Microsoft .NET 4.0 Framework is installed on the client machine. 

2. Browse to the Perspective Services URL: http://<IISServer>/PerspectiveServices. 

“IISServer” refers to the Perspective Web server installed in the previous section. 
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a. Click the Launch Perspective button. 

 

b. In the dialog box that opens, click Run. 

Note: If you are using the MSI Package installer, follow the procedures below. 

i. Browse to the Perspective Services URL: 

http://<IISServer>/PerspectiveServices/default.aspx?opt=2 

If you are using ?opt=1, only the Click-Once installer will be displayed.  

If you are using ?opt=0 or if Java Script is disabled or the Web Service is not a 

trusted site, both the Click-Once and MSI Package installer will be displayed. 

ii. Click the “Click here to Download MSI Package” and follow the on-screen 

instructions. If you experience any problems during the download of the MSI 

Package or the installation of the MSI client, please call the PPM 2000’s Technical 

Support team at 1-877-776-2995 for assistance. 

 

3. After Perspective downloads and installs, you're prompted to enter a URL. The URL should 

be automatically populated; if so, move to the next step. If not, enter your Perspective 

Services URL as before: http://<IISServer>/PerspectiveServices. <IISServer> refers to 

the Perspective Web server installed during the installation of Perspective. 
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Click the  icon right of the URL to proceed. 

 

4. Now you should be able to test the default Perspective logon. From this point onward, users 

must navigate to the Perspective Services URL to launch the Perspective application. 

 

To create a shortcut to the application on the client machine’s desktop, proceed as follows: 

1. Navigate to the Perspective Services URL.  

2. Right-click the Launch Perspective button and select Copy Shortcut. 

3. Right-click the client desktop and select Paste Shortcut. 

  Default Admin Master vs. Users with Administrator Rights 

As of Perspective Version 3.3, there are differences between the default Admin Master 

account and a Perspective User with Administrator rights. Specifically, the Admin Master 

has select features available that other Users, even with Administrator rights, do not. 

However, the default Admin Master can only access the Administration and 

Dashboard panels of Perspective. Other components are unavailable to the Admin 

Master; this account cannot be used for data entry. 

 

 

Perspective Default Logon 

User Name:  Admin 

Password:  Security 
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Install Perspective Integration Services (Optional)  

 

    DTC Note 

Perspective Integration Services requires the Microsoft
®
 Distributed Transaction 

Coordinator (DTC) service to be installed and enabled on the IIS Web Server and the 

Microsoft
® 

SQL Server
®
 for Perspective. 

1. From the Perspective Install > Web Service Setup > Integration Services directory, run 

setup.exe. 

2. Perspective Integration Services Setup Wizard dialog box will appear. Read the information 

contained within and proceed to follow the steps in the Wizard required to complete the 

installation process. Click Next. 

3. Read the PPM 2000 Software License Agreement in the following dialog box and select “I 

agree” to indicate your agreement with the terms outlined. Click Next. 

 

4. Select a Web location for the Integration Services installation by either accepting the 

provided default values or entering other applicable settings. 
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5. At this point, the installer is ready to begin the installation. Confirm your intention to start the 

installation process by clicking Next. 

6. At some point during the installation you will see another screen appear that will request you 

to specify the location of the Perspective directory. 

 

7. Wait while Integration Services is being installed. Click Close once installation is complete. 

    HTTP and SSL Note 

Perspective Integration Services’ Standard Install is configured to use the secure HTTPS 

setting and the SSL protocol. To change these and other default settings, please contact 

Technical Support at 1-877-776-2995 for the “Technical Support Knowledge Base— 

Perspective Integration Services Configuration” document. 
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Testing Perspective Implementation 

Once you have completed the steps outlined on the previous sections, please, go through the 

following steps to ensure that all Perspective’s components have been set up properly. 

1. Go to the Perspective Services URL and confirm that the page loads 

properly: http://<localhost>/perspectiveservices. 

2. If the above fails, go to the Perspective Services page and confirm that the page loads 

properly: http://<localhost>/perspectiveservices/service.asmx. 

3. Go to the Reports page and confirm that the page loads properly: 

http://<reportservername>/reports.  

Note: If your Reports page does not display correctly, run the PublishServerReports.bat 

file included in the Perspective Install > Reports Setup folder. 

 

4. Log on to the Perspective client—preferably not on the server itself—using your Perspective 

Administrator user name and password.  

5. Once you have logged on successfully, click on the Reports button in the Navigation pane 

(on the left-hand side of the screen) and confirm that all reports are listed. The easiest way 

to confirm that the client-side reports are working is to verify that there are reports listed 

under the <Detail Reports> heading, such as the Incident, Person and Vehicle Reports. Try 

to run any of the reports by clicking Preview. 

6. To confirm that the server-side reports are working, try running the Test Report under the 

<Administrative Only> node. If you receive an error message, please call the Technical 

Support team at 1-877-776-2995 for assistance. 

Note: The Report version should display as 3.3, while the Database version should display 

as 3.3.0. 
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Advanced Configurations 

With Perspective, your organization has a number of advanced configuration options available. 

Before attempting to implement any of the following options, we recommend that you complete 

the standard installation first; then, contact Technical Support (support@ppm2000.com) for 

further instructions.   

SSL on Your Web 

Service 

To secure and encrypt data sent to and from the Web service to 

client machines. 

Windows Authentication 
To allow users to log on to Perspective and to connect to SQL 

service using their Windows authenticated account 

IIS Compression 

To compress information sent from Web services to the client. 

(Recommended for installs with remote users who are not 

connected directly to the network. If all users are internal, 

compressing data may take longer than sending uncompressed 

data over a high-speed network.) 

Transparent Data 

Encryption (SQL 2008) 

For encrypting data at rest (for use with Microsoft SQL Server 

2008 Enterprise Edition only). 

Setting up 

Sample/Training 

Database 

Default setup supports one database only. If additional databases 

are required, these can be set up with assistance from Technical 

Support. 

AE Mirroring 
For sites with high volumes of data that require SQL intensive 

searches to be executed against a separate SQL server. 

Custom Pagination 

By default, the pagination feature is set to 100 records per page. 

This number can be modified (to any value from 20 to 1000 

records per page) by manually editing the 

<PaginationPageSize>100</PaginationPageSize> tag in the 

Perspective_Default.config file. 

Custom Legal Notice 

and Privacy Statement 

To customize Perspective’s legal notice and/or privacy statement 

for your organization, navigate to the Legal folder in the 

Perspective Services Virtual Directory, open the LegalNotice.mht 

or PrivacyStatement.mht file in an HTML editor (such as 

Microsoft Word), apply your edits, and save the file as an MHTML 

document with the original file name. 

mailto:support@ppm2000.com
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Set Up Additional Features Using 
Service Manager 

Perspective Service Manager is an external application available only on the Web server 

hosting Perspective services. It is used to manage configuration files, databases, licenses and 

keys, as well as to set up a number of important features in Perspective (i.e., email and mass 

notifications, attachments, Quick Find indexing, user-defined fields, Custom Search integration 

and Integration Services URL). 

To access Perspective Service Manager, go to C:\Program Files\PPM 2000 Inc\Perspective 

Services or open it from the Startup menu.  

Remember to complete each editing action in Perspective Service Manager by clicking Save 

Changes. To implement your settings in Perspective, restart Internet Information Services (IIS) 

(and the Perspective Web server). Note that restarting IIS will affect anyone currently logged on 

to Perspective. Ensure that all users have saved their work and exited the program prior to 

completing this step. 

Configuration 

Select the Configuration component from the Perspective Service Manager menu and open the 

Configuration tab. Click Browse to navigate to the Location of Server Configuration File.  

Note: This option would be used when Perspective Services has been installed in a different 

location than the default options. 
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Client-Side Configuration 

1. Select the Configuration component from the Perspective Service Manager menu and 

open the Client-Side Configuration tab. 

2. To update the configuration with a .zip file provided by the Technical Support, click Browse 

to navigate to the Location of Updated Client-Side Reports. The field below will indicate 

the Version of the client-side reports.  

3. Click Update Reports to Server to complete the update. 

Note: This option would be used if a newer version of client-side reports is available. 

 

Note: 'xxxx' in the above screenshot denotes the latest Perspective build number. 

Email Notifications 

In Perspective, users may send email notifications containing incident or case details or report 

attachments. Otherwise, email notifications may be sent, when new investigators are assigned to 

an investigation, or when assignments are created, modified or completed.  

Note: The Case and Investigation components are only available in the Perspective Premium. 

To set up email notification options, select the Configuration component in the Perspective 

Service Manager menu and open the Notification tab. 
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There are two options for configuring email settings in Perspective: Outlook
®
 or SMTP 

integration. Alternatively, email functionality can be disabled by selecting the “Do not use mail 

options” radio button.  

Option A: Outlook Integration 

Select Outlook (only) to order Perspective to utilize the active user’s local Outlook 2007 or 2010 

client to send emails. These emails are sent through the central Exchange Server and stored in 

the user’s Sent Items folder.  

Option B: Connect to an External SMTP Server 

To use an SMTP server to send emails from Perspective, switch the radio button from Outlook to 

SMTP and enter the appropriate information for connecting to the SMTP server: 

 Host: The domain name of the SMTP service. 

 Port: The port the SMTP service will be listening on for connections. 

 Username: A valid user name to connect to the SMTP service. 

 Password: The appropriate password for the user name. 

 Use Default Credentials: Rather than entering a particular user name and password, you 

can specify that a user’s Windows credentials be used to connect to the SMTP service. 

 Use Anonymous Access: As an alternative option, if the SMTP server does not require 

user credentials to connect and send email, you can enable users to connect anonymously. 

 Enable SSL: Select this option to encrypt the SMTP connection with Secure Socket Layer 

(SSL). 

 Reply Address: When sending email messages, the SMTP service must include a reply 

address. Enter the email address that you would like to appear on any email messages sent 

via SMTP. 

 The email settings outlined above will be used as system defaults for every client. With the 

exception of the reply address, all of these settings can be overridden for individual clients 

by specifying alternative settings under the client’s Settings > Options menu in 

Perspective. (The reply address is a global setting and will be used for anyone using 

SMTP.) If you do not want individual clients to have the option of overriding any of these 

settings, select the “Force all clients to use these settings” box. 
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Uploading Attachments 

Perspective allows users to attach any file type to any data record in the application. These files 

are stored directly in the SQL database and their size can be the greatest factor in determining 

how much space will be required in SQL. 

To set up the maximum attachment size, select the Configuration component in the Perspective 

Service Manager menu and open the Attachments tab. 

Perspective can support files up to 2 GB in size (SQL’s limit for binary data types); however, due 

to restrictions you may have on the space available for your Perspective database or bandwidth 

in your network, we do include an option to decrease this 2-GB limit to a size that can be better 

supported in your environment.  

 On SQL Standard or Enterprise, this value can be set between 1 MB and 2000 MB. The 

default is set to 250 MB.  

 On SQL Express, this value can be set between 1 MB and 50 MB. The default is 10 MB. 

Note: SQL Server Express is only supported for the Standard Edition of Perspective. 
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To change this value to an appropriate value for your organization, move the slider.  

 

Integration Services URL 

1. To enable event trigger in Integration Services, select the Configuration component from 

the Perspective Service Manager menu and open the Services tab.  

2. Enter the URL set up with the Integration Services in the Integration Services field. 

3. To enable trigger events on create and update, check the “Enable Trigger Notification” 

box. To enable context-sensitive events, check the “Allow Hot Key Events” box. 
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Custom Search Integration 

With Perspective’s Custom Search feature, you can integrate Perspective with the Infoglide 

Identity Resolution Engine
™

 (IRE) to search several data sources at once. Complete the following 

steps to enable this integration. Note that you must first configure your Perspective database 

within the Identity Resolution Engine before proceeding. 

To set up the Custom Search feature, select the Configuration component from the Perspective 

Service Manager menu and open the Services tab. Check the “Enable Custom Search (with 

Infoglide)” box and enter the URL for the Infoglide Identity Resolution Engine in the field below. 

Note: To access the Custom Search feature, users must be granted the appropriate access rights 

in Perspective. For details on administering Custom Search access for roles and users, see 

“Select general role rights” and “Set general user rights” in the “Roles” and “Users” sections of the 

Perspective Administrator’s Guide.  

 

Mass Notifications 

In Perspective, users can integrate their MIR3SM inEnterpriseTM solution into Perspective in order 

to send mass notifications about selected activities via Perspective DispatchLog.  

To set up the Mass Notification feature, select the Configuration component from the 

Perspective Service Manager menu and open the Services tab. Check the “Enable Mass 

Notification (with MIR3)” box and enter the Mass Notification URL, Username and Password 

provided by MIR3 in the field below. 
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Analysis Expert Tools 

If you experience difficulties with the correct Analysis Expert (AE) query display, this function 

must be used to update the AE .dat file provided by the Technical Support. 

1. Select the Configuration component from the Perspective Service Manager menu and 

open the AE Tools tab. 

2. Specify the SQL Server. 

3. Select either the Windows or SQL Authentication. If you selected SQL Authentication, 

enter the correct Username and Password. 

4. Choose the Database you wish to update your queries on. 

5. Specify the correct path to the AE .dat file provided by the Technical Support in the File 

Location field. 

6. Click Update. 
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Quick Find Indexing 

With Perspective’s Quick Find tool, you can quickly search for text anywhere in the database, 

including text within attachments. This works by scanning an index file generated on the server. 

1. To set up indexing on your database, select the Quick Find Indexing component in the 

Perspective Service Manager menu. 

2. To enable this feature, select Allow Quick Find. 

3. Select an Index Directory to store the index files. IIS must have access to read this 

directory. 

4. Optional: If large index files are expected, you can force the index cache to use a separate 

directory by checking “Specify folder in alternate drive to store cache while indexing?” 

and then selecting a directory. 

5. Optional: If you would like certain common words to be ignored when indexing (e.g., a, the, 

an, at, to, etc.), select “Use noise word file?” and specify the directory where your 

Noise.dat file exists. 

6. Optional: If you would like hyphenated words to be indexed as two separate words, you can 

select “Treat hyphens as spaces”. 

7. Optional: If you would like the index files to ignore any numeric text, you can select “Do not 

index numeric values”. 
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8. Select the Database you want to index. 

9. Expand the nodes listed under Tables and select each table you want data to be indexed 

from individually. Note that attachments are indexed separately from the main entities and 

can be found at the bottom of the list. 

10. Click Save Changes.  

11. Click Index to do an initial index of the database. 

12. Optional: Repeat steps 8-11 for additional databases. 

13. As data is added, deleted, or modified in the database, the index must be kept up-to-date. 

You can schedule the database to re-index using command line arguments and Windows 

scheduled tasks. To do this, create a scheduled task to run Perspective.ServerManager.exe 

with the option -index=  (or use the shorthand -i=) followed by the Database ID. 

For example: 

C:\Program Files\PPM 2000 Inc\Perspective Services\ 

Perspective.ServerManager.exe -i=Sample 
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User-Defined Fields 

Although user-defined fields (UDFs) can only be created by specialized users with access to both 

the server machine and the Service Manager, they are maintained by Administrators in the same 

manner as all other fields within Perspective. Visibility and access rights to a user defined field 

can be controlled under System Privileges, Role Privileges or User Privileges. UDF labels can be 

modified and created for other languages under Form Labels. Moreover, if the UDF is a lookup 

field, lookup values and workgroup visibility for these values can be customized under Lookups. 

You may add user defined fields to the Item, Person, Organization and Vehicle forms under the 

General tab, as well as to numerous sections of the Incident and Case forms.  

Note: The case component is only available in the Premium Edition of Perspective. 

1. To set up user defined fields for Perspective, select the User Defined Fields banner at the 

bottom of the Perspective Service Manager menu and open the General tab. 

2. In the Server Authentication section, specify the Database Name. Ensure that this 

information is correct before proceeding. The Form lookup list will become available. 

3. From the Form lookup list, select the data form in which you would like the new user 

defined field to appear. Your options are as follows: 

 Incidents 

 Incident Items (Involved Items) 

 Incident Organizations (Involved Organizations) 

 Incident Persons (Involved Persons) 

 Incident Vehicles (Involved Vehicles) 

 Items 

 Organizations 

 Persons  

 Vehicles 

 Cases 

 Activities 

4. From the Section lookup list, select the specific section of the form that you would like the 

user defined field to appear in. For all forms except Incidents and Cases, the only option 

available is the General tab. For the Incidents form, you may choose the General, 

Investigations (Details) or Controls tab. For the Cases form, you may choose either the 

General or Controls tab. 

Note: The Investigations tab is only available in the Premium Edition of Perspective.  

5. Click the Add button at the bottom of the window. An Add UDF dialog box will open. 

6. Enter the new user defined field’s name in the Field Name text box. Note that no special 

characters or spaces may be used—letters only. Then, assign the field its default System 

English Label. The System English label is what users will see on the Perspective form. 
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7. Choose the field type from the Data Type lookup list. The available field type options for 

UDFs are Number [for whole numbers], Decimal Number [for numbers with up to two 

decimal places], Text, Date, Yes/No [for a checkbox field] and Lookup List. If you selected 

Text as the data type, you may also specify the maximum number of characters that can be 

entered in the field under Text Length. 

 

8. Not Recommended: If you wish to make the user defined field a required field, check the 

System Required box. If you check this box, you will not be able to adjust the field-level 

security at any point in the future. If you wish to make the user defined field required, it is 

best to do so within Perspective at the system, Role or User levels. This allows greater 

flexibility for the future use of the field. 

9. Click Apply. The user defined field’s details will now appear under the General tab. 
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 To edit the user defined field, click the arrow to the left of the Field Name to select the entire 

row and click the Edit button. Make changes in the Edit UDF dialog box and click Apply. 

 To delete the user defined field, click the arrow to the left of the Field Name to select the 

entire row and click the Delete button. A Delete UDF confirmation window will open warning 

you of potential loss of data. If you choose to delete the selected UDF and click Yes, any 

data previously tracked in the UDF will be erased as well. Instead, it is recommended that 

you hide or lock the UDF within Perspective, if you no longer wish to use it to track data. 

10. To view the user defined field with its default form location, select the Layout tab. The Top 

and Left values indicate the number of pixels that the UDF will be located from the top left 

corner of the User Defined Fields section of the form. The User Defined Fields section 

always appears at the bottom of the form. 

 

 Click and drag the UDF label to move the UDF to an alternative location on the form. The 

entire scrollable window beneath the Layout tab is representative of the User Defined Fields 

section of the form. Click Save Layout to save the chosen UDF location on the form. 

 At any time, you may click Default Layout to return the UDF to its original assigned position 

on the form. To return the UDF to its last saved location, click Previous Layout. 

 

 



Perspective Installation Guide 

36 

Troubleshooting Tips 

Perspective Server 

  Ensure Perspective Services are set up 

1. Open IIS manager, navigate to the Perspective Services Virtual Directory, and try to browse 

the Service.asmx file. 

2. If the page that is displayed reads “Service”, the install was successful. 

If you get an error code page:  

a. Check the properties of the Perspective Services Directory and ensure it is running 

under Microsoft .NET 4.0 on the ASP.NET tab. 

b. Re-install Microsoft .NET 4.0 with ISS using the following command line: 

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis.exe 

  Connect to the database using ODBC 

1. Select Control Panel > Administrative Tools > Data Sources (ODBC), and open the System 

DSN tab. 

2. Click Add to create a data source, select SQL Server. Click Finish. 

3. Enter the name “Perspective” and select the name of your SQL Server. 

4. Click Finish, and then click Test Data Source. 

  Test the application pool 

An application pool is used to connect to the database server. To test if there is an issue with the 

Web application pool, change the account to Network Services and see if it runs. 

  Restart IIS 

Right-click your Computer icon and select Manage. Expand the Services and Applications 

folder and right-click Internet Information Services (IIS). Select All Tasks, then restart IIS and 

click OK. Another way to restart IIS is to run the command line issreset from the Start menu. 
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Database Server 

  Ensure that the database login account has been assigned DBO access rights 

1. In Enterprise Manager, select Security > Logins. 

2. Double-click the domain user account that the Perspective server uses to connect to the 

database (e.g., the test account “PerspectiveDBCon”). 

3. On the Database Access tab, select the Perspective database and ensure that dbo access 

is assigned.

  Ensure that your database is in compatibility mode for a SQL version other than SQL 2000 

In the Compatibility Settings in your SQL Database, ensure that your database is in compatibility 

mode for a SQL version other than SQL 2000. If it is not, follow the steps below: 

1. Open the Microsoft SQL Management Studio and expand Databases.  

2. Right-click on your Perspective Database and select Properties.  

3. On the left-hand column, select Options.  

4. In the Compatibility level field, select SQL 2008. 

Reporting Services Server 

For assistance and information on setting up SQL Reporting Services, view the deployment 

guide on Microsoft’s Web site: http://technet.microsoft.com/en-us/library/ms159868(SQL.90).aspx 

  Check the version of the Microsoft .NET Framework 

If .NET Framework 3.5 is enabled on the machine, only client-side components of Reporting 

Services will be installed. If necessary, remove the .NET Framework 3.5 before installing 

Reporting Services, and re-install 3.5 afterwards using the following command line: 

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe 

  Specify path for .bat file 

1. Using the Windows Start menu’s Search function, search for the rs.exe file. 

2. Place a copy of the rs.exe file in the Perspective Install > Reports Setup folder. 

http://technet.microsoft.com/en-us/library/ms159868(SQL.90).aspx
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Perspective Client 

  Connect to the Web site 

Open your Web browser and enter the following URL:  

http://<IIS Server Name>/PerspectiveServices/Service.asmx 

  Ensure SQL login account is configured properly 

The SQL login account (e.g., the test account “PerspectiveDBCon”) needs permissions. 

  Troubleshoot Windows authentication issues 

If you are having issues with the Active Directory
® 

single sign-on authentication, verify that the 

Server service has been started on the Web Server. 

 

If the problem persists, switch to the standard Perspective authentication to check if the 

connection is working. 

1. To diagnose if the problem is in the Windows authentication, test with Perspective 

authentication. On the Perspective Server, edit the Perspective_Default.config file as 

follows: 

 Change the authentication type to <Perspective>. 

 Change <Integrated Security=SSPI> to the SQL user and password. 

2. Restart IIS, and then attempt to logon again. 

  Troubleshoot application download issues 

1. If the client machine’s operating system is Windows XP, clear the contents of the following 

folder: C:\Documents and Settings\<username>\Local Settings\Apps\2.0. 

If the client machine’s operating system is Windows Vista or Windows 7, clear the 

contents of the following folder: C:\Users\<username>\AppData\Local\Apps\2.0. 



Perspective Installation Guide 

39 

Note: If you delete the contents of the folders, all Click-Once applications will be deleted. 

At any time, contact the Technical Support team at 1-877-776-2995 for assistance. 

2. Browse to the Perspective Services URL: http://<IIS server name>/PerspectiveServices. 

3. Click the Launch Perspective button to re-download the entire Perspective application. 

4. In the dialog box that opens, click Run. The Perspective client will automatically launch.  

5. Enter the Perspective Services URL (e.g., http://IISServer/PerspectiveServices), and click 

OK. 

6. Proceed to log on. 

Integration Services 

Integration Services requires MS DTC (Microsoft
®
  Distributed Transaction Coordinator). Ensure 

the following  options are enabled and refer to the information on Microsoft’s website using the 

links provided. 

1. Enable Network DTC Access for MS DTC transactions. Follow the instructions in the To 

enabled Network DTC Access for MS DTC transactions section on this page: 

http://technet.microsoft.com/en-us/library/cc753620(v=ws.10).aspx 

2. Enable XA Transactions. While on the same tab opened in the previous step, select the 

Enable XA Transactions check box. 

3. Enable Firewall Exceptions for MS DTC.  Follow the instructions on this page: 

http://technet.microsoft.com/en-us/library/cc725913(v=ws.10).aspx 

 

  

http://technet.microsoft.com/en-us/library/cc753620(v=ws.10).aspx
http://technet.microsoft.com/en-us/library/cc725913(v=ws.10).aspx
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Error Messages 

Error Message Explanation 

No Connection. Perspective Client error 

Solution 

 Launch the Perspective client from the Perspective server and attempt to logon. 

 Make sure the user account is a member of the IIS_WPG group on the Perspective server. 

Response is not well formed .XML. Perspective Client error 

Solution 

 May be due to a missing bracket or other formatting issue in the 

Perspective_Default.config file. 

 May also be a permissions issue. See your local Security Policy. 

Connection to the service not found/SQL 

Exception/Login failed for user. 
Perspective Server error 

Solution 

Ensure the application pool account has access to the database. The account that the 

Perspective server is using to connect to the database must be specified as the Application Pool 

identity, and requires membership in the IIS_WPG. 
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Contact Information 

Technical Support 

Toll Free:   1-877-776-2995 

Phone:    (780) 448-0616 

Email:    support@ppm2000.com 

PPM 2000 

Toll Free:   1-888-PPM-9PPM (1-888-776-9776)  

Phone:    (780) 448-0616 

Fax:    (780) 448-0618 

Email:    information@ppm2000.com 

Website:   http://www.ppm2000.com 

  

mailto:support@ppm2000.com
mailto:information@ppm2000.com
http://www.ppm2000.com/
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